
Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ajit K. Ghosh 2019 Natinal Fusarium 
Heald Blight Forum 12/8/2019 Wisconsin Lodging x $198.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Registration x $175.00 

Chemist USWBSI, University of 
Kentucky 12/10/2019 12/8/`9-12/10/19

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

AMS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

USWBSI, University of 
Kentucky

BENEFIT SOURCE

BENEFIT SOURCE
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Completing the General Information

Renaming the Spreadsheet Tabs
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Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Luis Caniz
Guatemalan/Honduras 
Delegation Port of Entry 
Visit

10/21/2019 Houston & Laredo, 
Texas

Common Carrier  
Taxi/Shuttle x                  x $580.00     

$200.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging              
Meals x                  x $720.00    

$396.00

Agricultural Specialist Instituto Interamericano de 
Cooperation Agricola 10/25/2019 109/20/19-10/26/19 Insurance x $85.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lori Gustafson

OIE ad hoc group on 
susceptibility of fish 
species to infection with oie 
listed diseases

12/3/2019 Paris, France Taxi/Shuttle         
Lodging x                  x $150.00    

$1,616.00

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

APHIS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

Instituto Interamericano de 
Cooperation Agricola

BENEFIT SOURCE

OIE World Organizationf 
or Animal Health

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $1,457.00 

VMO OIE World Organization for 
Animal Health 12/5/2019 12/1/19-12/6/19 Common Carrier x $1,300.00 

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Tara McHugh Nominations and Elections 
Committee Meeting 10/28/2019 Chicago, IL Common Carrier x $600.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $500.00 

Center Director Institute of Food Tech 10/30/2019 10/28/19-10/30/19 Meals x $50.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

James J. Giovannoni
International Conference on 
Integrative Plant Physiology 
2019

10/27/2019 Barcelona, Sitges, 
Spain Common Carrier x $1,604.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging              
Meals x                 x $444.00    

$288.00
Molecular Biologist Elsvier 10/29/2019 10/29/19-10/30/19 Registration x $1,021.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Rick Millerd US Taiwan Rice Technical 
Meeting 11/5/2019 Taoynan Warehouse Common Carrier 

Baggage Fees x                 x $1,000.00 
$$50.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging              
Hotel Taxes x                 x $174.00     

$100.00

BENEFIT SOURCE

Institute of Food 
Technologists

BENEFIT SOURCE

Elsvier

BENEFIT SOURCE

USA Rice Federation

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

ARS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Senior Board Member USA Rice Federation 11/6/2019 11/2/19-11/7/19 Meals x $200.00 



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Sue Prada

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Steven Kappes Genome-wide Association 
Study meeting 10/27/2019 Tainan, Taiwan Air Transportation x 1556

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x 100

Associate Administrator
Livestock Research 
Institute - Council of 
Agriculture

11/2/2019 10/26 - 11/2/2019 Lodging x 832

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Cynthia Parr
ASA-CSSA-SSSA 
International Annual 
Meeting

11/10/2019 San Antonio, TX Per Diem x 305

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x 1200

Technical Info. Specialist American Society of 
Agronomy 11/13/2019 11-9 - 11/13/2019 Airfare & Parking x 460

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

John Finley Invited Seminar Speaker 10/7/2019 St. Paul, MN Air Transportation x 230

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x 151

BENEFIT SOURCE

Livestock Research 
Institute - Council of 

Agriculture

BENEFIT SOURCE

American Society of 
Agronomy

BENEFIT SOURCE

University of Minnesota

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

sue.prada@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA - ARS
AFM-HQ-ONP & NAL

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

National Program Leader University of Minnesota 10/8/2019 10-7 - 10/8/2019 Per Diem x 82.5



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit a 
negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in 
PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination 
that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting 
cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming 
convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  
Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab 
between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the 
total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) 
and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select 
"Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the 
bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing 
sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear 
(e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the 
button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area 
that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set 
Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as 
an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is 
no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in 
the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left 
of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- 
and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 
for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in 
the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with 
a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file 
will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Karen Hughes

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Martin Williams Fall Seminar Series 10/7/2019 Durham, New 
Hampshire Hotel X $500.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $676.91 

Res Ecologist University of New 
Hampshire 10/8/2019 10/4/2019-10/8/2019 Meals X $244.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Elizabeth Ainsworth Board Meeting 10/10/2019 Washington, DC Hotel X $275.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $690.00 

Supvy Plant Physiologist Foundation for Food and 
Agricultural Research 10/11/2019 10/10/2019-

10/11/2019
Meals/Ground 
Transportation X $194.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Carl Bernacchi 2019 CABBI 
Biogeochemical Modeling 10/10/2019 Ft Collins, CO Hotel X $348.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $488.00 

BENEFIT SOURCE

University of New 
Hampshire

BENEFIT SOURCE
Foundation for Food and 

Agricultural Research

BENEFIT SOURCE
Center for Advanced 

Bioenergy and Bioproducts 
Innovation (CABBI), 
University of Illinois

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

Karen.Hughes@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA-ARS
MidWest Area

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Res Plant Physiologist

Center for Advanced 
Bioenergy and Bioproducts 
Innovation (CABBI), 
University of Illinois

10/11/2019 10/9/2019-10/12/2019 Local 
Transportation X $100.00 



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit a 
negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in 
PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination 
that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting 
cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming 
convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  
Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab 
between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the 
total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) 
and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select 
"Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the 
bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing 
sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear 
(e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the 
button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area 
that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set 
Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as 
an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is 
no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in 
the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left 
of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- 
and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 
for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in 
the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with 
a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file 
will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Paula DiSabella

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jalal Jabro
International Conference 
on Sustainable Agriculture 
and Environment (ICSAE)

10/3/2019 Konya, Turkey Hotel X $480 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Registration X 200

Research Soil Scientist
International Conference 
on Sustainable Agriculture 
and Environment (ICSAE)

10/5/2019 10/01/2019 - 
10/06/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kate Larson

University of Connecticut 
Department of Nutritional 
Sciences Seminar Series 
(speaking engagement)

10/4/2019 Storrs, CT Air Transportation X $700 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $94 

Research Agricultural 
Engineer University of Connecticut  10/4/2019 10/03/2019 - 

10/04/2019

Meals
Ground 
Transportation

X $83
$60

BENEFIT SOURCE

Selcuk University, Turkey

BENEFIT SOURCE

University of Connecticut  

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

paula.disabella@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA - Agricultural Research Service
Plains Area

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jeffrey Carroll
11th International 
Technical Meeting Levucell 
SB 

10/23/2019 Paris, France Air Transportation x $1,215 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x $2,000 

Supervisory Research 
Physiologist Lallemand SAS 10/24/2019 10/21/2019 - 

10/25/2019
Ground 
Transportation x $100 

BENEFIT SOURCE

Lallemand SAS
3

LOCATION

TRAVEL DATE(S)



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Paula DiSabella

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Manuel Borca
2019 International 
Symposium for Classical 
Swine Fever

10/21/2019 Beijing and Tianjin, 
China Air Transportation X $2,500 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $800 

Research Microbiologist China Institute of 
Veterinary Drug Control 10/29/2019 10/21/2019 - 

10/28/2019

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Douglas Gladue

Haid Research Institute 
Speaking Engagement and 
2019 International 
Symposium for Classical 
Swine Fever 

10/21/2019 Guangzhou and 
Beijing, China Air Transportation X $2,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $500 

Research Microbiologist
Guangdong Agricultural 
Science and Technology 
Innovation Center

10/26/2019 10/19/2019 - 
10/26/2019

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               LOCATION BENEFIT SOURCE

2

LOCATION BENEFIT SOURCE

Guangdong Agricultural 
Science and Technology 

Innovation Center

TRAVEL DATE(S)

1

LOCATION BENEFIT SOURCE

China Institute of 
Veterinary Drug Control

TRAVEL DATE(S)

EX

LOCATION BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

TRAVEL DATE(S)

TRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

BENEFIT SOURCE

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

NEGATIVE 
REPORTNortheast Area

paula.disabella@usda.gov

No.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

USDA - Agricultural Research Service
x

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

TOTAL 
AMOUNT

BENEFIT 
DESCRIPTION



 

TRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

BENEFIT SOURCE

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

TOTAL 
AMOUNT

BENEFIT 
DESCRIPTION

Manuel Borca

SCHOOL OF 
VETERINARY MEDICINE 
& BIOMEDICAL 
SCIENCES (SVMBS) 
SEMINAR SERIES

11/25/2019 Lincoln, NE Air Transportation X $650 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $300 

Research Microbiologist University of Nebraska-
Lincoln 11/25/2019 11/24/2019 - 

11/26/2019

3
University of Nebraska-

Lincoln

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select 
"Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the 
bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing 
sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear 
(e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit a 
negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in 
PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination 
that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting 
cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming 
convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  
Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab 
between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the 
total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) 
and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in 
the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left 
of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- 
and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 
for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in 
the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as 
an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is 
no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the 
button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area 
that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set 
Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with 
a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file 
will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Lisa Jackson-Beitia

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lindsay H. Allen American Society for 
Nutrition Board Meeting 10/6/2019 Washington, DC Lodging X $250 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare X $1,000 

Research Physiologist American Society for 
Nutrition  10/7/2019 10/06/2019-

10/07/2019

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lindsay H. Allen
International Life Sciences 
Institute (ILSI) Annual 
Meeting 2020

1/20/2020 San Jose, Costa Rica Lodging X $882 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare X 1585.26

Research Physiologist International Life Sciences 
Institute (ILSI) 1/21/2020 01/17/2020-

01/23/2020 Taxi X 290

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Roberto Avena-Bustillas
Attend Applications of 
Biopolymers in the Food 
Industry Workshop

10/14/2019 Pamploma, Spain Lodging X $1,200.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $1,500 

Research Food 
Technologist

Universidad Publica de 
Navarra 10/18/2019 10/11/2019 - 

10/21/2019 Meals x $500.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA-ARS
Pacific West Area

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

lisa.jacksonbeitia@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

American Society for 
Nutrition

BENEFIT SOURCE

International Life Sciences 
Institute

BENEFIT SOURCE

Universdad Publica de 
Navarra

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 2020

Agency Contact: Tracy Kita

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lindsay Allen
Food and Nutrition Board: 
Pregnancy Lactation 
Workshop

1/29/2020 Washington D.C. Air Transportation x $1,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x $600 

Research Physiologist
National Academies of 
Sciences, Engineering and 
Medicine

1/30/2020 01/28/2020 - 
01/31/2020 Meals x $100 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Nahia Bassil
North American Rasberry 
and Blackberry Association 
Meeting

3/3/2020 St Louis, MO Air Transportation x $500 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Plant Geneticist
North American Rasberry 
and Blackberry Association 
Meeting

3/7/2020 03/02/2020 - 
03/08/2020                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

National Academies of 
Sciences, Engineering, 

and Medicine

BENEFIT SOURCE

University of Arkansas

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tracy.kita@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA-ARS
Pacific West Area

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Michael Branstetter

Bee Genomics Meeting 
and Working 
Group/Australian Bee 
Conference

12/5/2019 Brisbane, Australia Air Transportation x $2,100 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x $300 

Research Entomologist Centre for Biodiversity 
Analysis 12/7/2019 12/02/2019 - 

12/08/2019                            

Australian National 
University3

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 2020

Agency Contact: Lindsey Sheffield

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jinyoung Barnaby Climate Change Scientist 
Forum 10/21/2019 Lima, Peru Air Transportation x $1,600 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x $900 

Research Plant 
Physiologist

National Institute of 
Agriculturlal Innovation 10/25/2019 10/192019-10/26/2019 Meals x $500 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mark Berrang Conference on Poultry 
Health 10/8/2019 Ocean City, MD Hotel x $250 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

meeting 
registration x $200 

Research Microbiologist Delmarva Poultry Industry 10/9/2019 10/07/2019-
10/10/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Frederick Breidt Conference & Product 
Showcase 10/22/2019 St. Petersburg, FL Air Transportation x $300 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x $800 

Microbiologist Pickle Packers 
International, Inc. 10/24/2019 10/21/2019-

10/24/2019                            

BENEFIT SOURCE

National Institute of 
Agricultural Innovation

BENEFIT SOURCE

Delmarva Poultry Industry

BENEFIT SOURCE

Pickle Packers 
International, Inc.

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

lindsey.sheffield@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA-ARS
Southeast Area - East

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2020



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit a 
negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in 
PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination 
that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting 
cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming 
convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  
Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab 
between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the 
total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) 
and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select 
"Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the 
bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing 
sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear 
(e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab 
must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the 
button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area 
that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set 
Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as 
an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is 
no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in 
the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left 
of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- 
and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 
for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in 
the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with 
a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file 
will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 1 2020

Agency Contact: Cack Norquist

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Alfred Handler

Meeting on Generic 
Approach for the 
Development of Genetic 
Sexing Strains for SIT 
Applications

10/7/2019 Vienna, Austria Air Transportation X $2,229 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $820 

Research Geneticist International Atomic 
Energy Agency (IAEA) 10/11/2019 10/5/2019-

10/12/2019
Meals & ground 
transportation X $1,015 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Alan Franzluebbers
International Workshop on 
Integrated Animal-Crop 
Production Systems

10/9/2019 Quzhou, China Air Transportation X $3,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $400 

Research Ecologist China Agricultural 
University 10/11/2019 10/8/2019-

10/12/2019
Meals & ground 
transportation X $700 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

Food & Agriculture 
Organization of the United 
Nations and International 
Atomic Energy Agency 

(IAEA)

BENEFIT SOURCE

National Academy of 
Agriculture Green 

Development, China 
Agriculture University 

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

cack,norquist@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA-ARS
Southeast Area - West

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

C. Corley Holbrook, Jr
International Conference 
on Advances in Arachis 
Through Biotechnology 

10/21/2019 Jinan, China Air Transportation X $1,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $200 

Research Geneticist The Peanut Foundation 10/25/2019 10/19/2019-
10/26/2019 Train X $50 

The Peanut Foundation 
3

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 2020

Agency Contact: Sue Prada

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jayachandran N Variyam

Speaking engagement - 
Food Security and 
Sustainable Agriculture 
Forum

10/30/2019 Seoul, South Korea Lodging X 920

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X 400

Director, Food 
Economics Division

Ministry of Agriculture, 
Food, and Rural Affairs 
(MAFRA) of the Republic 
of Korea and the Asian 
Development Bank Institute

11/1/2019 10/28 - 11/3/2019 Common Carrier X 1500

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ronald Sands
Asia-Pacific Integrated 
Model (AIM) International 
Workshop

11/18/2019 Tsukuba, Japan Air Transportation x 2000

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x 450

Sr. Economist National Institute for 
Environmental Studies 11/19/2019 11-16 - 11/20/2019 Meals x 150

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA
Economic Research Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

sue.prada@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Asian Development Bank 
Institute (ADBI) and Korea 
Rural Economic Institute 

(KREI)

BENEFIT SOURCE

National Institute for 
Environmental Studies

BENEFIT SOURCE

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

3
TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Meghan E. Adler 2019 Food & Nutrition 
conference & Expo 10/25/2019 Phildelphia, PA Common Carrier x $1,055.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging               
Meals x $719.00 

Nutritionist Academ;y of Nutrition & 
Dietics 10/29/2019 10/24/19-10/30/19

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert M. Hubbard

Investigating the sudden 
death of national native 
treee Araucaria aracucana 
under climate change.

12/2/2019 Concepcion Chile Common Carrier x $2,000.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,800.00 

Research Ecologist University of Concepcion 
Chile 12/10/2019 11/30/19-12/11/19 Meals x $800.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

Academy of Nutrition 
Dietics

BENEFIT SOURCE

University of Concepcion

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FNS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

3
TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Calkin European Forest Institute 
Workshop on Wildfire Risk 10/14/2019 Madrid, Spain Common Carrier x $1,000.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $678.00 

Research Forester European Forest Institute 
Workshopon Wildfire Risk 10/15/2019 10/9/19-10/16/19

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Brett J. Butler Annual Meeting of the 
Texas Forestry Association 10/7/2019 Texas Common Carrier 

Rental Car x                  x $644.00    
$150.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $94.00 

Research Forester Texas Forestry Association 10/17/2019 10/16/19-10/17/19 Per Diem (at Gov 
Rate) x $82.50 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

European Forest Institute

BENEFIT SOURCE

Texas Forestry 
Association

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FOREST SERVICE - 2
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Gary D. Vaughn
Intergovernmental 
Wilderness & Wild & 
Scenic Rivers Seminar

3/16/2020 India Lodging x $140.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $40.00 

Natural Resource 
Specialist

Rajasthan Forest 
Department 3/18/2020 3/11/20-3/28/20 Miscellaneous x $40.00 

Rajasthan Forest 
Department3

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

William A. Phillips Learning from Unintended 
Outcomes 11/4/2019 Canada Common Carrier  

Taxi/Shuttle x                  x $1,310.00  
$50.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $800.00 

Training Specialist British Columbia Wildfire 
Service 11/8/2019 11/3/19-11/9/19 Lodging x $800.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Terry Swinscoe Learning from Unintended 
Outcomes 11/4/2019 Canada Common Carrier  

Taxi/Shuttle x                  x $1,310.00  
$50.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $800.00 

Risk Management 
Officer

British Columbia Wildfire 
Service 11/8/2019 11/3/19-11/9/19 Lodging x $800.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kimberly Ann Lightley Learning from Unintended 
Outcomes 11/4/2019 Canada Common Carrier  

Taxi/Shuttle x                  x $1,310.00  
$50.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $800.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FOREST SERVICE
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

British Columbia Wildfire 
Service

BENEFIT SOURCE

British Columbia Wildfire 
Service

BENEFIT SOURCE

British Columbia Wildfire 
Service

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 Risk Management 
Program Specialist

British Columbia Wildfire 
Service 11/8/2019 11/3/19-11/9/29 Lodging x $800.00 



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jose Emilio Esteban

Advisory Group Mtg. 
Practical Guidance for 
Codes Electronic Working 
Groups

1/30/2020 Brussels, Belgium Common Carrier  
Taxi/Shuttle x                 x $1,700.00   

$100.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $668.00 

Chief Scientist Codex Alimentarius 1/31/2020 1/28/20-2/1/20 Meals x $400.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

BENEFIT SOURCE

Codex alimentarius

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FSIS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Meghan E. Adler 2019 Food & Nutriti8on 
Conference & Expo 10/25/2019 PA

Common Carrier  
Lodging              
Meals

x $1,055.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] other expenses x $719.00 

Nutritionist Academy of Nutritionand 
Dietetics 10/29/2019 10/24/19-10/29/19

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mai Dinh Medicasl Marijuan & Hemp 
Law Symposium 3/20/2020 PA Lodging x $189.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Parking x $55.00 

Asst. General Counsel Pennsylvania Bar Institute 3/20/2020 3/19/2020-3/20/2020

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

HEADQUARTERS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Academy of Nutrition and 
Dietetics

BENEFIT SOURCE

Pennsylvania Bar Institute

BENEFIT SOURCE

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 2020

Agency Contact: Sue Prada

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA
National Agricultural Statistics Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

sue.prada@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

1 2020

Agency Contact: Sue Prada

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

sue.prada@usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under 
other authority.  For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

USDA
National Institute of Food and Agriculture

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X X

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2019

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Tanse Herrmann
South Dakota Agricultural 
& Rural Leadership 
International Study Seminar

2/16/2020 Cambodia Common Carrier  
Taxi/Shuttle

x                   
x

$3,000.00  
$400.00   

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x                   

x $1,000.00 

District Conservationist South Dakota Agricultural 
& Rural Leadership 2/28/2020 2/15/20-2/28/20 Meals x $1,000.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Curtis Bradbury Prescribed Fire Training 
Exchange 3/18/2020 Nebraska Common Carrier x $608.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

State Biologist Nature Conservancy 3/18/2020 3/18/18-3/18/18

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mark Hayek Prescribed Fire Training 
Exchange 3/18/2020 Nebraska Common Carrier x $608.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

NRCS
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31, 2019

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2019

3

LOCATION

Asia Pacific Forum Pacific 
Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

South Dakota Agricultural 
& Rural Leadership

BENEFIT SOURCE

Nature conservancy

BENEFIT SOURCE

Nature conservancy

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

State Rangeland 
Management Spec. Nature Conservancy 3/18/2020 3/18/20-3/18/20

3
TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-
hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells 
that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file 
as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information 
in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-
- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would 
read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of 
sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined 
with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs

Semiannual Report of Payment Accepted



Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation



Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acrony         
1353travel@oge.gov



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA

    d



EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR



OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

               ym for your agency, please contact OGE at 



PAGE OF PAGES YEAR

2020

Agency Contact:
USDA, 
Headquarters, Office 
of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-Pacific 
Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

James Wilson
2019 KTA-TTA Fall 
Conference/KTEA Annual 
Conference

10/15/2019 Kentucky Registration Fee` x $100.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

GFR
Kentucky 
Telecommunications 
Association

10/18/2019 10/15/19-10/18/19

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ben Doyle REDWnG Rural Economy 
Listening Tour 11/18/2019 Grafton INN Lodging x $129.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $130.00 

Associate Enterprise 
Director Sara Coffey 11/19/2019 11/18/19-11/19/19 Meals x $55.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Bette Brand Farm Credit University Ag 
Biz conference 1/8/2020 North Caroloin Per Diem (at Gov 

Rate) x $150.00 

BENEFIT SOURCE

Kentucky 
Telecommunications 

Association Conference

BENEFIT SOURCE
Windham Foundation and 

Preservatoin Trust of 
Vermont

BENEFIT SOURCE

Ag Biz/Carolina Farm 
Credit

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tobin.andrew@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

3

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

RURAL DEVELOPMENT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2019- MARCH 

31, 2020

REPORTING 
PERIOD: APRIL 1 

- SEPTEMBER 
30, 2020



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Administrator Ag Biz/Carolina Farm 
Credit 1/9/2020 1/7/20-1/9/20

3
TRAVEL DATE(S)


	AMS AD-1101s (October  2019 - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	APHIS AD-1101s  (October 2019 - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS AD-1101s (October 2019-March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS-HQ-AFM-ONP-NAL_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS-MWA-NEA_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS-NEA-PA_OGE-1353
	Instruction Sheet
	Agency Acronym
	Plains Area
	NorthEast Area

	ARS-PWA_OGE-1353 - Pg 1
	Instruction Sheet
	Agency Acronym
	USDA WHNRC

	ARS-PWA_OGE-1353 - Pg 2
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS-SEA-East_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ARS-SEA-West_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	ERS_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	FNS AD-1101s (April 2019 - September 2019)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	FOREST SERVICE - 2 -  AD-1101s (October 2019- March 2020) 
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	FOREST SERVICE AD-1101s (October 2019  - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	FSIS AD-1101S (October 2019 - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	HEADQUARTERS AD-1101s (October 2019 - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	NASS_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	NIFA_OGE-1353
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	NRCS  AD-1101s (October 2019 - March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM

	RURAL DEVELOPMENT AD-1101s (October 2019-March 2020)
	Instruction Sheet
	Agency Acronym
	RENAME BLANK FORM


